Splunk® ODBC Driver Install and Use
Splunk ODBC Driver 2.1.1

Generated: 12/05/2018 12:56 am
# Table of Contents

**Introduction** ........................................................................................................ 1  
  About Splunk ODBC Driver.............................................................................. 1  
  What’s new in Splunk ODBC Driver............................................................ 1  
  How Splunk ODBC Driver fits into your Splunk Enterprise environment.... 1  
  Get support and find out more information about Splunk Enterprise........ 2  

**Install Splunk ODBC Driver** ........................................................................... 3  
  Installation Prerequisites............................................................................. 3  
  Install the Splunk ODBC Driver................................................................. 4  
  Verify installation....................................................................................... 5  
  Enter or change configuration information................................................ 6  
  Proxy Server Configuration....................................................................... 7  
  TLS Certificate Configuration..................................................................... 8  
  Load Balancer Configuration..................................................................... 9  

**Use Splunk ODBC Driver** ............................................................................... 10  
  Use the driver with Microsoft Excel............................................................ 10  
  Use the driver with Tableau...................................................................... 13  
  Use the driver with MicroStrategy............................................................... 17  
  How to take advantage of data model support in the Splunk ODBC Driver... 22  

**Frequently Asked Questions (FAQs)** .............................................................. 25  
  Frequently Asked Questions (FAQs).......................................................... 25  

**Troubleshooting** .......................................................................................... 27  
  Troubleshooting......................................................................................... 27
Introduction

About Splunk ODBC Driver

The Splunk ODBC Driver enables you to connect Microsoft Excel, Tableau Desktop, and MicroStrategy Analytics Desktop to Splunk Enterprise through Open Database Connectivity (ODBC). You can then visualize and report Splunk data directly from Excel, Tableau, or MicroStrategy.

What's new in Splunk ODBC Driver

Splunk ODBC Driver version 2.1.1 added the following fixes:

- An issue with certain builds of libcurl.dll caused corruption in payload.
- Fixed ODBC Driver description to remove old version string (0.8).

Splunk ODBC Driver version 2.1.0 added the following features:

- Support for TLS 1.2 has been added.
- Support for SSL has been removed.
- Searches that return no results (invalid searches, empty indexes, or searches that have no results) no longer generate an exception. The empty set is returned.

How Splunk ODBC Driver fits into your Splunk Enterprise environment

ODBC is a mechanism that enables ODBC-compliant apps to access data sources such as database management systems and now—using the Splunk ODBC Driver—a Splunk Enterprise server.

The following diagram illustrates how Excel, Tableau, or MicroStrategy accesses Splunk Enterprise through the Splunk ODBC Driver. Within Excel, Tableau, or MicroStrategy, you configure the ODBC Driver Manager, which uses the Splunk ODBC Driver to access your Splunk Enterprise Server.
The main advantage of using the Splunk ODBC Driver to connect an app to Splunk Enterprise is the ability to use a familiar interface (such as Excel, Tableau, or MicroStrategy) to perform actions that you might not be as comfortable doing with Splunk. For example, you don't have to use the Search Processing Language (SPL) to interact with a Splunk Enterprise server. You can instead use the Query Wizard in Excel or the interface in Tableau. The Splunk ODBC Driver then translates your actions in the app to SPL behind the scenes.

Get support and find out more information about Splunk Enterprise

Support for the Splunk ODBC Driver is provided by Splunk support. If you need support, go to http://www.splunk.com/support to find out how to submit a case.

You can also find help through the broader community at:

- Splunk Answers (use the odbc tag to identify your questions)
- Splunkdev Google Group

You have a variety of options for finding more information about Splunk:

- The core Splunk Enterprise documentation
- Splunk Answers
- The #splunk IRC channel on EFNET
Install Splunk ODBC Driver

Installation Prerequisites

The Splunk ODBC Driver is currently available for Windows only.

You must install the Splunk ODBC Driver on the Windows PC that runs the application you want to use it with (Excel, Tableau, or MicroStrategy). However, it does not need to be installed on the computer that is running Splunk Enterprise.

Though running the Splunk ODBC Driver and Splunk Enterprise on the same Windows PC is a supported configuration, you can use the Splunk ODBC Driver to connect to Splunk Enterprise running on any supported platform, including Linux, OS X, Solaris, and so on.

To install the Splunk ODBC Driver, you need the following components.

Splunk platform requirements:

- A Splunk Enterprise version earlier than 7.x running on any supported operating system

Client computer (running Splunk ODBC Driver):

- Windows 7 or later (including Windows Server 2008 R2 and later Windows Server versions)
- Microsoft Excel 2010 or later, Tableau Desktop 8.1 or later, or MicroStrategy Analytics Desktop 9.4 or later

**Note:** The Splunk Enterprise computer and the client computer can be the same computer.

---

**Install the Splunk ODBC Driver**

The Splunk ODBC Driver is not supported on Splunk platform versions 7.x. Upgrading your Splunk platform to 7.x can cause breaking changes to the Splunk ODBC Driver.

To install the Splunk ODBC Driver:

1. Install the Microsoft Visual C++ 2010 Redistributable Package, as described in "Installation Prerequisites".
2. Download and unzip the driver. The Splunk ODBC Driver contains both a 32-bit installer and a 64-bit installer. Unless you use the Splunk ODBC Driver with a 64-bit application such as the 64-bit edition of Microsoft Excel, install the 32-bit version of the Splunk ODBC Driver.

**Important:** Install the version of the driver that corresponds to the type of app that you use to connect to Splunk Enterprise—that is, 32-bit or 64-bit. For example, if you are running a 32-bit version of Microsoft Excel, install the 32-bit version of the Splunk ODBC Driver, even if you're running a 64-bit edition of Windows. If you don't know whether you have the 32- or 64-bit version of your app installed, then see the app's "About" screen. To find out whether these applications are 32- or 64-bit, do one of the following:

◊ In Excel 2010, click the **File** tab, and then click **Help**. The version number under "About Microsoft Excel" will have "(32-bit)" or "(64-bit)" after it.
◊ In Excel 2013, click the **File** tab, and then click **Account**. Under **Product Information**, click **About Excel** to open the **About Microsoft Excel** window. The first line of the window tells you whether this version is a 32- or 64-bit edition.
In Tableau, on the Help menu, click About Tableau. The line at the top will state which version it is. MicroStrategy Analytics Desktop is available only as a 32-bit application.

3. Open the appropriate installer, click Next, read the license agreement, and, if you accept the terms, select the top option and click Next.

4. (Optional.) Change the default install directory (located in the Program Files directory) and click Next.

5. On the Create a Data Source screen, enter the requested information. (To configure the driver later, see "Configuration").
   a. Login ID: Enter a user ID for your Splunk server. The user ID doesn’t have to be assigned an admin role. For more information about users and roles, see "About users and roles".
   b. Password: The password field is not enabled. To save the password for your Splunk instance with the ODBC driver, select the Enter and Save Password box, and type your password. If you leave this box unselected and the field empty, you must enter the password every time you connect to the Splunk server.
   c. Server URL: Enter the URL of the Splunk Enterprise server. This field has the address of a local Splunk server. If the Splunk instance to which you’re connecting isn’t running locally, enter the Splunk server’s address. Include the right scheme (the default scheme is HTTPS), as well as the port number. The default port number is 8089. Do not enter the Splunk Web port (port 8000). If your Splunk setup has a load balancer, enter the address of the load balancer instead. For more information, see “Load Balancer Configuration”.

6. Click Next, and then click Install. When the install is finished, click Finish.

Verify installation

To verify that the Splunk ODBC Driver was installed successfully:

1. Click the Start button (or, in Windows 8, go to the Start screen).
2. Type odbc.
3. Click whichever of the following items that appears. If more than one appears, click the one that corresponds to the ODBC Driver architecture you installed: Data Sources (ODBC), 32-bit ODBC Data Source Administrator, or 64-bit ODBC Data Source Administrator.

4. In the ODBC Data Source Administrator window, click the System DSN tab and look for "Splunk ODBC" in the list of system data sources, as shown in the following screen shot.

Enter or change configuration information

To enter or change configuration information, do the following:

1. From the Start screen (or on the Start menu), type odbc.
2. Click whichever of the following items that appears. If more than one appears, click the one that corresponds to the ODBC Driver architecture you installed: Data Sources (ODBC), 32-bit ODBC Data Source Administrator, or 64-bit ODBC Data Source Administrator.
3. In the ODBC Data Source Administrator window, click the System DSN tab.
4. Click Splunk ODBC in the list of system data sources.
5. Click Configure. The Splunk ODBC Connection Options window appears.
6. In this window, you can change any of the options described in "Install the Splunk ODBC Driver", plus the following additional option:

- **Verify Server SSL Certificate**: This checkbox instructs the Splunk ODBC Driver to ensure the integrity of the Splunk Enterprise server’s SSL certificate. Select this checkbox if your server is across a firewall from the computer on which you’re running the Splunk ODBC Driver. Follow the instructions in “SSL Certificate Configuration”.

### Proxy Server Configuration

You cannot contact Splunk Enterprise instances that are on networks that require proxy servers without additional configuration. Add an environment variable to the computer that runs the Splunk ODBC Driver.

If your network requires proxy servers, on the computer running the Splunk ODBC Driver, add one of the following environment variable names, depending on the protocol of the management port (that is, HTTP or HTTPS):

- https_proxy
- http_proxy

The driver checks the environment variable that corresponds to the protocol of the management port. The variable’s contents should be in the following format:

```
[protocol://][user:password@]proxy_machine[:port]
```

Within this string, `protocol://` is ignored if present, and the optional `:port` number specifies the host's port on which the proxy operates. For more
information, see "Environment Variables".

**TLS Certificate Configuration**

If the computer on which you're running the Splunk ODBC Driver is across a firewall from the Splunk Enterprise server, Splunk recommends that you instruct the driver to verify a signed certificate upon connection with the server. To do this, install a valid certificate for the management port on your Splunk Enterprise server, and enable the **Verify Server SSL Certificate** option in the driver.

Be aware that if you instruct the driver to verify a signed certificate, you must configure a TLS certificate on the Splunk Enterprise server. (The default self-signed certificate is not sufficient.) Not configuring a certificate on the Splunk Enterprise server causes the connection to fail.

**Note:** Splunk ODBC Driver 2.1.0 and later supports only Transport Layer Security (TLS) version 1.2. SSL is no longer supported.

To set up this functionality:

1. On the Splunk Enterprise server, configure one or more certificates.
2. Point splunkd (the Splunk Enterprise back-end) to your certificate files by editing *server.conf*. Here's an example of an edited *sslConfig* stanza:
   ```
   [sslConfig]
   enableSplunkdSSL = true
   sslKeysfile = server.pem
   sslKeysfilePassword = password
   caCertFile = cacert.pem
   caPath = $SPLUNK_HOME/etc/auth
   ```
3. On the computer on which you've installed the Splunk ODBC Driver, follow the instructions in "Configuration" to open the **Splunk ODBC Connection Options** window.
4. Check the box next to **Verify Server SSL Certificate**.

**Note:** Do not set `requireClientCert` to `true` in `server.conf`. The Splunk ODBC Driver does not use an SSL client certificate, so this setting causes the connection to fail.
Load Balancer Configuration

If your Splunk Enterprise installation uses load balancing to distribute data across multiple Splunk instances, configure the Splunk ODBC Driver accordingly.

When you set up the Splunk ODBC Driver (or change its configuration), in the Server URL field of the Create a Data Source screen (during driver install) or the Splunk ODBC Connection Options window (when updating the configuration information), enter the address of the load balancer instead of the address of a Splunk instance.

For more information about changing the Splunk ODBC Driver's server URL, see "Configuration".
Use Splunk ODBC Driver

Use the driver with Microsoft Excel

The Splunk ODBC Driver is not supported on Splunk platform versions 7.x. Upgrading your Splunk platform to 7.x can cause breaking changes to the Splunk ODBC Driver.

You can access Splunk Enterprise data from Microsoft Excel 2010 and 2013 (32-bit or 64-bit) using the Splunk ODBC Driver version 1.0 and later.

To use the Splunk ODBC Driver to get Splunk data into Microsoft Excel:

1. Open a new worksheet in Excel.
2. Click the Data tab.
3. In the Get External Data group, click From Other Sources, and click From Microsoft Query.
4. In the Choose Data Source window, click Splunk ODBC.
5. Select the Use the Query Wizard to create/edit queries checkbox.
6. Click OK.

Microsoft Query connects to your Splunk Enterprise server.

Note: Using the Query Wizard is the supported method for creating queries with Excel.

The Choose Columns window of the Query Wizard appears after Microsoft Query opens.

The tables listed in the Available tables and columns pane map to the saved searches you created in Splunk.
Expand or collapse a table:

- Click the plus sign (+) or the minus sign (-) next to the table name.

Move columns into the query:

- Click the name of the column (each of which corresponds to a field in Splunk) in the left pane, and click the > button to move it to the query.

Change the order of columns in the query:

- In the right pane, click the column name, and click the up or down arrow button to move it up or down, respectively.

Remove columns from the query:

- Click the column name in the right pane, and click the < button to remove it.

**Note:** Table joins are not supported. Add columns from just one table to the query. Otherwise, the following error dialog box appears.

When you’re done choosing columns, click Next. The Filter Data window of the Query Wizard appears. The columns that you chose appear in the left pane.

Filter results:
1. Choose the column to filter from the left pane.
2. Specify criteria to filter on in the right pane. For example, in the screenshot, we included only rows in the `category_id` column that do not equal GIFTS.

When you’re done adding filter criteria, click **Next**. The **Sort Order** window of the Query Wizard appears. In this window, you choose how to sort the results that Splunk returns.

Specify how to sort data:

1. Choose a column name from the list box under **Sort by** to sort on that column.
2. Specify any secondary sorting in the next list box, and so on.

When you’re done choosing sorting order, click **Next**. The **Finish** window of the Query Wizard appears. You can either return the data to Excel or to view or edit the query in Microsoft Query. Choose an option, and click **Finish**.

If you chose the first option, the data that corresponds to the options you chose will be returned to Excel. If you see the error message "The query returned no
results" after you click **Finish**, your criteria was too specific, or in some other way did not select any results. Click **OK**, and click **Back** a few times to reenter your search criteria.

For more information, see "Use the Query Wizard to define a query" on the Microsoft Office website.

**Use the driver with Tableau**

You can access Splunk Enterprise data from Tableau Desktop using the Splunk ODBC Driver version 1.0 and later.

**Note:** To access Splunk Enterprise data from Tableau, ensure you've installed the version of the Splunk ODBC Driver that corresponds to the architecture version of your Tableau install. That is, install the 32-bit version of the Splunk ODBC Driver if you're running 32-bit Tableau, and install the 64-bit version of the Splunk ODBC Driver if you're running 64-bit Tableau.

**Connect Tableau 8.2 and later to Splunk Enterprise data**

The Splunk ODBC Driver is not supported on Splunk platform versions 7.x. Upgrading your Splunk platform to 7.x can cause breaking changes to the Splunk ODBC Driver.

To use the Splunk ODBC Driver to get Splunk Enterprise data into Tableau 8.2 and later:

1. Open a new workbook in Tableau.
2. On the **Data** menu, click **Connect to Data**.
3. In the **Connect to Data** pane, scroll to the bottom and click **Splunk**.
4. In the **Splunk Connection** window, enter a server URL and login credentials, and then click **Connect**. Be sure to prepend the URL with **https://**.

5. Once Tableau has connected to Splunk, choose a table from the list that appears. (Each table corresponds to a saved search, or *report* in Splunk Enterprise 6 and later.)

6. Give the connection a name, and then click **OK**.

7. In the **Data Connection** window, choose whether to connect directly to your Splunk data or import all of the returned Splunk Enterprise data:
   - **Connect live**: Tableau returns you to your workbook. This option creates a direct connection to Splunk Enterprise and is dependent on the speed of your Splunk Enterprise server. You can refresh the data at any time.
   - **Import all data**: The **Save As** window appears. Enter a name for the data extract, and click **Save**. Tableau extracts all of your data. It returns you to your workbook. For more information, go to [http://www.tableausoftware.com/support](http://www.tableausoftware.com/support) and search for "Extracting Data". This option lets you work with a snapshot of your Splunk Enterprise data.
   - The **Import some data** option is not supported.

**Connect Tableau 8.1 and earlier to Splunk Enterprise data**

To use the Splunk ODBC Driver to get Splunk Enterprise data into Tableau 8.1 and earlier, first enable an ODBC connection from Tableau to the Splunk ODBC server.
Driver by copying the Splunk.tdc file from the Splunk ODBC Driver directory into the Tableau datasources directory.

After you install the Splunk ODBC Driver, the Splunk.tdc file is placed at the following path: C:\Program Files\Splunk ODBC Driver\Tableau\. If you’re running a 64-bit edition of Windows and you install the 32-bit version of the Splunk ODBC Driver, the driver directory will be located in the Program Files (x86) directory. Copy the Splunk.tdc file to the datasources directory, whose default location is at the following path: C:\Users\username\Documents\My Tableau Repository\Datasources.

For more information, see "Query Isolation Levels" on the Tableau Software Knowledge Base website.

Now you can connect to Splunk Enterprise:

1. Open a new workbook in Tableau.
2. On the Data menu, click Connect to Data.
3. In the Connect to Data pane, scroll to the bottom and, under On a Server, click Other Databases (ODBC).
4. In the Generic ODBC Connection window, under Connect Using, select DSN.
5. From the popup menu, click Splunk ODBC and click the Connect button.

Note: Ignore the fields under Connection Attributes. Also leave the Schema field empty.
6. Under **Table**, select the **Single Table** option, and then click the magnifying glass icon on the right side of the field to get a list of the tables you can use. As you can see, the available tables map to the reports (*saved searches* in Splunk Enterprise 5) you have created in Splunk Enterprise.

   **Note:** The **Multiple Tables** and **Custom SQL** options are not supported.

7. Enter a name to give the connection, and click **OK**.

8. In the **Data Connection** window, choose whether to connect directly to your Splunk Enterprise data or import all of the returned Splunk data:
   - **Connect live:** Tableau returns you to your workbook. This option creates a direct connection to Splunk Enterprise and is dependent on the speed of your Splunk Enterprise server. You can refresh the data at any time.
   - **Import all data:** The **Save As** window appears. Enter a name for the data extract, and click **Save**. Tableau extracts all of your data. It returns you to your workbook. For more information, go to http://www.tableausoftware.com/support and search for "Extracting Data". This option lets you work with a snapshot of your Splunk Enterprise data.
   - The **Import some data** option is not supported.

   **Note:** If you don't see any tables listed after connecting—or if you don't see the tables you expected—see **Tables aren't visible after connecting** in the Troubleshooting section.

In your workbook, you can construct queries. Construct your query using SQL or the **Splunk Search Processing Language (SPL)**, depending on what you chose when you configured the driver. (The default query language is SQL; see "Configuration"). For more information about using Tableau, see "Tableau and ODBC", or press F1 to access the application's built-in help.

**Filter support limitations**

Using filters in Tableau is equivalent to creating subsearches in Splunk Enterprise. The more subsearches that you create, the more performance drags are possible. Using Tableau to create Splunk Enterprise searches obscures the actual search commands that the Splunk ODBC Driver translates from SQL.

Creating multiple dimension filters using Tableau might have a performance impact, especially when working with a large set of results. There is a limit to how many results will be returned by subsearch and how long a subsearch can take.
See About subsearches for more information.

Splunk recommends that, for better performance, you push as much filtering as you can into the report (saved search in Splunk Enterprise 5) itself within Splunk Enterprise rather than implementing extensive filtering in Tableau.

**Use the driver with MicroStrategy**

The Splunk ODBC Driver is not supported on Splunk platform versions 7.x. Upgrading your Splunk platform to 7.x can cause breaking changes to the Splunk ODBC Driver.

You can access Splunk Enterprise data from either MicroStrategy Analytics Desktop version 9.4.1 or later or MicroStrategy Analytics Enterprise version 9.4.1 or later using the Splunk ODBC Driver version 2.0 and later.

**Note:** To access Splunk Enterprise data from MicroStrategy, ensure you've installed the 32-bit version of the Splunk ODBC Driver.

**Connect MicroStrategy Analytics Desktop to Splunk data**

To use the Splunk ODBC Driver to get Splunk data into MicroStrategy Analytics Desktop:

1. Open MicroStrategy Analytics Desktop, and in the pane on the left, click Import, and then click Data.
2. On the Select your data source page, click Database.
3. In the Database connections pane, click the New connection button (the plus "+" icon).
4. In the Database connection window, select DSN Connections.
5. For each entry under Enter the database connection information, do the following:
   - **DSN:** Click the pop-up menu, and choose Splunk ODBC.
   - **DBMS:** Leave the pop-up menu set to Generic DBMS.
   - **User:** Enter your Splunk Enterprise username.
   - **Password:** Enter the Splunk Enterprise password for the user you entered in User.
6. Enter a name for the connection, and then click OK.
7. In the **Database connections** pane, click the name that you gave the new connection. MicroStrategy Analytics Desktop connects to your Splunk Enterprise server.

**Important** If at this point you see an ODBC error message, please contact MicroStrategy Support to request the "Splunk ODBC metadata fix." Once you apply the fix and restart MicroStrategy Analytics Desktop, you will be able to continue with these instructions. The fix is anticipated to be included in the next maintenance release of MicroStrategy Analytics Desktop.

The tables that appear in the **Available tables** pane map to the reports (also known as **saved searches**), data models, and data model objects that are defined in Splunk Enterprise and available to the logged in user. Data models and their objects are listed as follows: `data_model_object in data_model`. For example, if you wanted to use the **Ticket Management** data model and its **Problem** data model object, you would look for the entry in the table list called **Problem in Ticket_Management**.

To view a list of available columns in a table, click the **Expand** icon next to the table name. The columns in the table are listed, along with their data types.

To add a table to your imported data, drag the name of the table from the table list into the Editor panel in the middle of the page. The table and all the columns it contains appear in a box in the Editor panel.

For more information, see the MicroStrategy Analytics Desktop PDF documentation—specifically, the **Select the data to be imported** subsection of the **Importing data from a database** section.
Connect MicroStrategy Analytics Enterprise to Splunk data

**Note:** This section describes how to get going with the Splunk ODBC Driver and MicroStrategy Analytics Enterprise. It assumes that MicroStrategy Intelligence and Web Server have been installed and configured. Splunk recommends you read the *MicroStrategy Analytics Enterprise Installation and Configuration Guide* for detailed information about connecting MicroStrategy to data sources via ODBC. Chapters 5 and 6, "Configuring and Connecting Intelligence Server," and "Deploying MicroStrategy Web and Mobile Server" are particularly useful for explaining how to configure the MicroStrategy suite. Depending on your installation, the guide is most likely located at the following path: Start menu -> All Programs -> MicroStrategy Documentation -> Product Manuals -> Installation and Configuration Guide (PDF).

Once you’ve installed the Splunk ODBC Driver and configured MicroStrategy components, you have a choice of two methods with which to connect MicroStrategy to Splunk Enterprise data:

- Data Import
- Query Builder

**Data Import**

Data Import mode in MicroStrategy Analytics Enterprise is similar to connecting to Splunk Enterprise with MicroStrategy Analytics Desktop, which is described in the previous section. You bring Splunk Enterprise data into MicroStrategy and use MicroStrategy to create visualizations with the data.

To use the Splunk ODBC Driver to get Splunk data into MicroStrategy Analytics Enterprise using Data Import mode:

1. Open MicroStrategy Web, and log in to your Splunk project. If you haven’t yet set up your Splunk project in MicroStrategy, see Chapter 5, "Configuring and Connecting Intelligence Server,"—and, in particular, the section titled "Communicating with databases: ODBC and DSNs"—to learn how to do so.
2. In the pane on the left of the page, click **Create**, and then click **Import Data**.
3. On the **Select your data source page**, click **Database**.
4. In the **Database connections pane**, click the **New connection** button (the plus "+" icon).
5. In the **Database connection window**, select **DSN Connections**.
6. For each entry under **Enter the database connection information**, do the following:
   - **DSN**: Click the pop-up menu, and choose **Splunk ODBC**.
   - **DBMS**: Leave the pop-up menu set to **Generic DBMS**.
   - **User**: Enter your Splunk Enterprise username.
   - **Password**: Enter the Splunk Enterprise password for the user you entered in **User**.
7. Enter a name for the connection, and then click **OK**.

8. In the **Database connections** pane, click the name that you gave the new connection. MicroStrategy Analytics Desktop connects to your Splunk Enterprise server.

   **Important** If at this point you see an ODBC error message, please contact MicroStrategy Support to request the “Splunk 6.0 Object” and instructions to add the object. Once you apply the object and restart MicroStrategy, you will be able to continue with these instructions. The fix is anticipated to be included in the next maintenance release of MicroStrategy Analytics Enterprise.

The tables that appear in the **Available tables** pane map to the reports (also known as **saved searches**), data models, and data model objects that are defined in Splunk Enterprise and available to the logged in user. Data models and their objects are listed as follows: **data_model_object in data_model**. For example, if you wanted to use the **Ticket Management** data model and its **Problem** data model object, you would look for the entry in the table list called **Problem in Ticket_Management**.

To view a list of available columns in a table, click the **Expand** icon next to the table name. The columns in the table are listed, along with their data types.

To add a table to your imported data, drag the name of the table from the table list into the Editor panel in the middle of the page. The table and all the columns
it contains appear in a box in the Editor panel.

**Query Builder**

In Query Builder mode, MicroStrategy sends queries to Splunk Enterprise over ODBC and displays the results in the selected visualization. Every time the visualization is refreshed, the Splunk Enterprise data is refreshed, providing real-time Splunk Enterprise data.

To use the Splunk ODBC Driver to get Splunk data into MicroStrategy Analytics Enterprise using Query Builder mode:

1. Create a report the Query Builder interface in MicroStrategy Developer.
2. Create a visualization on top of the report in MicroStrategy Web.

**Create a report the Query Builder interface in MicroStrategy Developer**

1. Open MicroStrategy Developer, and log in to your Splunk project. If you haven't yet set up your Splunk project in MicroStrategy, see Chapter 5, "Configuring and Connecting Intelligence Server,"—and, in particular, the section titled "Communicating with databases: ODBC and DSNs"—to learn how to do so.
2. In the pane on the left of the window, select your Splunk project, go to **Public Objects -> Reports**, and then right-click somewhere within the pane on the right. From the pop-up menu, point to **New**, and then click **Report**.
3. In the New Grid window, click the **Freeform Sources** tab, and then click the **New ODBC Source** button.
4. In the Database Instances window, enter a name for the database instance name, select **Generic DBMS** in the **Database connection type**
pop-up menu, and then click **New**.

5. In the Database Connections window, enter a name for the database connection, select **Splunk ODBC DSN** (or whatever you've called the Splunk ODBC Driver's DSN) under **Local system ODBC data sources**, and then click **New**.

6. In the Database Login window, provide a database login name, login ID and password, and click **OK**.

7. Back in the Database Connections window, select the newly created Splunk database login, and click **OK**.

8. Back in the Database Instances window, select the newly created Splunk database connection, and click **OK**.

9. Back in the New Grid window, select the newly created Splunk database instance. Then select **Create Query Builder Report** and click **OK**.

MicroStrategy Developer connects to your Splunk Enterprise server and provides an interface for query building just like in Data import mode. You can now create and save a report.

For more information about using Query Builder to create reports, see the ?Customize your SQL queries: Query Builder? section of Chapter 11 of the *MicroStrategy Advanced Reporting Guide*. Depending on your installation, the guide is most likely located at the following path: Start Menu -> All Programs-> MicroStrategy Documentation -> Product Manuals -> Advanced Reporting Guide (PDF)

**Create a visualization on top of the report in MicroStrategy Web**

To create a visualization using a report in MicroStrategy Web:

1. Open MicroStrategy Web, and log in to your Splunk project.
2. In the pane on the left, click **Create**, and then select **New Dashboard**.
3. On the Select Dataset page, under **Use Existing**, browse to the report created in the previous section, and then click **Next**.

You can now start creating visualizations on the report (dataset) connected to Splunk Enterprise.

**How to take advantage of data model support in the Splunk ODBC Driver**
The Splunk ODBC Driver natively supports accessing data models that have been defined on your Splunk Enterprise instance. Just like with reports (also known as saved searches), once you’ve created a data model object and its attributes, the Splunk ODBC Driver does all the work to expose that data model object to your ODBC-enabled app.

Data models map semantic knowledge about one or more datasets. The data model encodes the domain knowledge that is necessary to generate specialized searches of those datasets. Data models are what enable you to use pivots to produce useful reports and dashboards without having to write the searches that generate them. Data models contain data model objects, which are essentially specifications for a dataset. Each data model object represents a different dataset within the larger set of data that Splunk Enterprise indexes.

**Important:** Before using data models and their objects through the Splunk ODBC Driver, you should be comfortable with their concepts. If you don’t already have data models defined on your Splunk Enterprise instance, consider installing the Splunk Common Information Model add-on, which includes several pre-defined data models.

To learn more about data models, see the following topics:

- About data models
- Manage data models
- Design data models and objects

How to access data models

You access data models in much the same way you access reports (also known as saved searches). Data model objects will appear to you as tables in whatever app you are using with the Splunk ODBC Driver to connect to Splunk Enterprise.

To work with data models and their objects:

1. Before choosing the data model and data model object in your ODBC-connected app, decide on the data models and data model objects you want to work with. Make a note of the exact names of both the data model and the specific data model object you want to access.
2. Using your chosen app (Excel, Tableau, or MicroStrategy), create a new data connection.
3. When the time comes to choose a table and columns to use, find the data model and object you noted in step 1. They will be listed as follows: *data_model_object in data_model*. For example, if you wanted to use...
the **Ticket Management** data model and its **Problem** data model object, you would look for the entry in the table list called **Problem in Ticket_Management**, as shown in this screen shot from the Microsoft Excel Query Wizard:

You can now proceed just as you would if you were accessing reports using the driver. For more information about what to do next, refer to the documentation in this manual that is specific to your ODBC-enabled app:

- Excel
- Tableau
- MicroStrategy
Is my Splunk password encrypted?

Yes, the Splunk ODBC Driver encrypts your Splunk password using Windows data protection APIs. You cannot turn off this encryption.

Can I use the Splunk ODBC Driver if my network requires a proxy?

Yes, you can use the Splunk ODBC Driver on networks that require proxy servers. To enable this scenario, add an environment variable to the computer that runs the Splunk ODBC Driver.

For information about configuring the Splunk ODBC Driver on a network with proxy servers, see "Proxy Server Configuration".

Does the Splunk ODBC Driver support the new data models in Splunk Enterprise 6.x?

Yes, the Splunk ODBC Driver supports data models in Splunk Enterprise 6.x. To learn more, see How to take advantage of data model support in the Splunk ODBC Driver.

What keywords or portions of keywords can't be used as field names?

Some SQL keywords or portions of keywords are reserved. You cannot use them as field names. They include the following:

- avg
- hour
- key
- max
- min
- second
My report has a space in its name. Is it compatible with the Splunk ODBC Driver?

Do not use a report (saved search in Splunk Enterprise 5) with a space in its name with the Splunk ODBC Driver. It might result in an error. Use the Splunk Enterprise rename function to replace any spaces in report names with underscores.

How do I ensure secure communication between the Splunk ODBC Driver and my Splunk Enterprise instance over a firewall?

The Splunk ODBC Driver checks your Splunk Enterprise server’s certificate. To enforce this option:

1. Follow the instructions in the "Configuration" section.
2. In the Splunk ODBC Connection Options window, select the Verify Server SSL Certificate checkbox.

Splunk ODBC Driver 2.1.0 and later supports TLS 1.2. It does not support SSL. For more information, see TLS Certificate Configuration.

Is Preview Now supported in Excel?

When you set up a query with the Query Wizard in Microsoft Excel, Excel allows you to preview your results by clicking the Preview Now button. The Splunk ODBC Driver does not support previewing results.

Why is the Splunk ODBC Driver app directory labeled as version 0.8?

The Splunk ODBC Driver's app directory has a "0.8" in its name.

This is not indicative of the version of the driver. To determine the version of the Splunk ODBC Driver that you have installed, go to Control Panel > Programs > Programs and Features, search for "odbc," and look in the Version column for the Splunk ODBC Driver.
Troubleshooting

Speed issues

To speed up your searches using the Splunk ODBC Driver, use the same techniques that you use to speed up Splunk searches.

1. Be specific in your searches. For example, put a keyword search into the first search command. Narrow the search as quickly as possible—ideally, before the first pipe.
2. Use report acceleration to speed up transforming searches and reports that cover a large volume of data. See "Manage report acceleration".
3. Use summary indexing to increase reporting efficiency. Summary indexing is useful when you have large datasets and/or long time ranges to search. Learn more about summary indexing (and how to set it up) by reading "Use summary indexing for increased reporting efficiency".
4. If you're using data models that represent large data sets, use data model acceleration to complete pivots more quickly. Whereas summary indexing speeds up individual searches on a per-report basis, data model acceleration speeds up reporting for a specific set of attributes that you've defined in a data model. For more information and to determine whether data model acceleration is for you, see "Accelerate data models".
5. When using data model acceleration, use the pivot and tstats search commands to speed up searches with the help of .tsidx files. .tsidx files are time-series index files, or summaries of the data returned by an accelerated data model. You can also use tscollect to create a .tsidx directory without using data model acceleration. You will need to manage, maintain, and refresh it manually.

Search the Splunk Docs and Splunk Answers sites to find out what the Splunk documentation and other Splunk users recommend.

Proxy servers prevent communication with Splunk Enterprise instances

You might not be able to contact Splunk Enterprise instances that are on networks that require proxy servers without some additional configuration. To enable this scenario, you'll need to add an environment variable to the computer
that runs the Splunk ODBC Driver.

For more information about configuring the Splunk ODBC Driver on a network with proxy servers, see "Proxy Server Configuration".

**Tables are not visible after connecting**

You connect to your Splunk instance in Excel or Tableau, and you cannot see any tables, or the tables you see aren’t the ones you expected. There are several possibilities for what’s wrong:

**Your connection attributes are incorrect.**

Check your connection attributes by following the instructions in "Enter or change configuration information". Is the server URL correct? Is the port number correct? By default, the port for splunkd is 8089. splunkd is what the Splunk ODBC Driver is connecting to. You can also try the following:

1. Click the Start button (or, in Windows 8, go to the Start screen), and type odbc. Click whichever of the following that appears: Data Sources (ODBC), 32-bit ODBC Data Source Administrator, or 64-bit ODBC Data Source Administrator.
2. In the ODBC Data Source Administrator window, click the System DSN tab, and then click "Splunk ODBC" in the list of system data sources.
3. Click the Configure button. The Splunk ODBC Connection Options window appears.
4. Copy the URL listed next to Server URL.
5. Open a browser window, paste the URL into the address bar, and press Enter.

**Note:** If at this point you see a window warning you about a problem with a security certificate, choose the option to
continue.

A window that looks like the following appears.

6. Click the link for "services".
7. When prompted, enter the same credentials that you entered when you configured the Splunk ODBC Driver.

If, after you click OK, you see an expanded list of endpoints, then the credentials you entered are correct. If not, reenter the credentials by following the instructions in "Enter or change configuration information".

**Your permissions are incorrect or insufficient.**

If your permissions are incorrect or insufficient, you might prevent the Splunk ODBC Driver from seeing the saved searches you're expecting. The tables that you see in Excel and Tableau map to saved searches in Splunk. If you don't have permissions to see certain saved searches, they do not appear as tables either.

"Saved search not found" message

You will see the error message "Saved search not found: . " when you try to access a report (saved search in Splunk Enterprise 5) that has an underscore in its name through the Splunk ODBC Driver version 1.0.
This is a known issue in version 1.0 of the Splunk ODBC Driver that has been fixed in version 1.0.1. Download and install the latest version using the instructions in "Install the Splunk ODBC Driver".

"Login failed" error message

If you see the following error message when you try to connect your ODBC-capable application to Splunk, your login information is not correct.

Reenter your login information for your Splunk server. You must have the correct user name and password for the user account with which you want to access the Splunk server. In addition, change your Splunk password from the default "changeme" password or the Splunk ODBC Driver will not connect to your Splunk instance.

See "Enter or change configuration information" and check that you entered the login information correctly.

"Table not found" error message

If you see a "Table not found" error message when you try to connect your ODBC-capable application to Splunk Enterprise, you might have a licensing issue.

Ensure that your license is up to date:

1. Log into Splunk Enterprise.
2. In Settings, click Licensing under System.

Make sure that you have a valid Splunk Enterprise license installed, and that its status is "valid" (not "expired").
Driver doesn't appear in data sources

The Splunk ODBC Driver doesn't appear in the list of data sources.

When you choose the Splunk ODBC data source, you might not see "Splunk ODBC" in the list of data sources. You probably installed the 64-bit version of the Splunk ODBC Driver, but you're trying to use it with a 32-bit application, or vice-versa. Install the appropriate version of the Splunk ODBC Driver and try again.

Connection or host name resolution errors

I get connection errors or host name resolution errors.

If you see any of the following error messages when you try to connect your ODBC-capable application to Splunk, your computer is having trouble contacting the Splunk server.

If your computer is running the Splunk instance that you're trying to connect to, make sure it is started:

In Windows 7, click the Start button, point to All Programs, point to Splunk, and then click Splunk. In Windows 8, click Splunk on the Start screen. If you see a
login screen, try to connect again. If you cannot, something else is wrong. See the "Splunk Troubleshooting Manual".

If you're connecting to a server running Splunk somewhere on your network, see if you can access it using your browser. If not, contact your network administrator.

If you can access your server, but you receive one or more of these error messages, check your configuration. See "Enter or change configuration information" and check that you entered the host name and port information correctly.

**Tableau identified limitations... error message**

*When I set up an ODBC connection in Tableau, I get an error message titled "Tableau identified limitations for the ODBC data source."*

If you get the following error message after you click **OK** in the Generic ODBC Connection setup window in Tableau, you need to copy the Splunk TDC file to your Tableau datasources folder.

![Copy the Splunk.tdc file](image)

See "Copy the Splunk.tdc file" for instructions.

**Excel joins or joining tables error messages**

*When I use the driver with Microsoft Excel, I get an error message about joins or joining tables.*

You see one of the following error messages when you try to add more than one table to your query in Microsoft Query, or when you try to add columns from more than one table in the Query Wizard.
You can include only one table in your query. Each table corresponds to a report (saved search in Splunk Enterprise 5) in Splunk. If your table doesn't include the columns you want, verify in Splunk that the corresponding report is returning the results you expect, and modify the query if necessary.

**Tableau doesn't display new reports (saved searches)**

Consider the following scenario: You connect to Splunk Enterprise using Tableau and work while connected live to an existing search. While connected to that Splunk instance separately (for example, using Splunk Web), you create a new report (saved search in Splunk Enterprise 5). Back in Tableau, the new report is not available as a table. Even if you disconnect and reconnect to the Splunk instance, the new report is still not visible.

This is expected behavior. To see the updated list of reports, exit and relaunch Tableau, and connect again.

**Note:** You need to relaunch Tableau only when you add or change reports (saved searches). Adding or changing fields doesn't have this requirement; simply perform a refresh within Tableau.

**Tableau doesn't display new or changed fields**

If you add new fields or change an existing field in Tableau while connected to Splunk, you might not see the new or changed fields right away. To see them, simply refresh the workbook.

**Note:** Unlike reports (saved searches in Splunk Enterprise 5), which require a relaunch of Tableau when added or changed, adding or changing fields require only a refresh within Tableau.
Null fields aren't handled in the same way as with other database systems

Null fields are not handled in the same way as you might be used to with other database systems. For example, they might inconsistently appear when you add or remove columns to your query.

This behavior is expected. To prevent this from happening, add functionality to your report (saved search in Splunk Enterprise 5) that gives null fields a constant literal value—for example, the string "Null". This ensures that null fields appear consistently.

"Invalid username/password" error message

When you connect to Splunk Enterprise 6.x using Tableau 8.1.8 or later and the Splunk ODBC Driver 1.0 or later, you may receive an "invalid username/password" error. This error may appear even when you have entered a valid username and password combination. Splunk and Tableau are both aware of this issue, and are working to resolve it as soon as possible.

The "invalid username/password" error occurs when connecting to a Splunk Enterprise instance whose main index contains no data. Its other indexes may have data, but if the main index is empty, you will see this error.

To work around this error, ensure that the main index of Splunk Enterprise instance to which you’re connecting contains at least some data.